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1

Important

Safety

Information for Europe:
Know these safety symbols

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

(CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

A A

The ‘exclamation mark’ calls attention to
features for which you should carefully read the
supplied literature to prevent operating and
maintenance problems.

The ‘lightening bolt’ symbol indicates uninsulated
components within the product that can cause
an electric shock.

To reduce the risk of fire or electric shock, do
not expose the product to rain or moisture and
do not place any objects filled with liquids, such
as vases, on the product.

OEO®EOEOO

©

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this product near water.
Clean only with dry cloth.

Do not block any ventilation openings.
Install in accordance with the
manufacturer’s instructions.

Do not remove the casing of this product.

29

@ Do not expose the product to dripping /

@

®

©)

splashing water, rain or high humidity.

Keep this product away from direct
sunlight, naked flames or heat.

Do not install near any heat sources
such as radiators, heat registers, stoves,
or other electrical equipment (including
amplifiers).

Do not place any other electrical
equipment on the product.

Do not place any sources of danger
on the product (e.g. objects containing
liquids, burning candles).

This product may include batteries. Please
refer to safety and disposal instructions
for batteries in this user manual.

Where the mains plug or an appliance
coupler is used as the disconnect device,
the disconnect device shall remain readily
operable.

Warning

* Never remove the casing of this apparatus.

Never lubricate any part of this apparatus.

Never place this apparatus on other electrical
equipment.

Keep this apparatus away from direct sunlight, naked
flames or heat.

Ensure that you always have easy access to the power
cord, plug or adaptor to disconnect this apparatus from
the power.

Warning

* To avoid injuries, never put your fingers into the bass

pipe (1) or your hands into the aluminum ring (2).




Risk of overheating! Never install this apparatus
in a confined space. Always leave a space of

at least four inches around this apparatus for
ventilation. Ensure curtains or other objects
never cover the ventilation slots on this
apparatus.

Mains fuse

This information applies only to products with a
UK mains plug.

This product is fitted with an approved molded
plug. If you replace the fuse, use one with:

e the ratings shown on the plug,

*  aBS 1362 approval, and

*  the ASTA approval mark.

Contact your dealer if you are not sure about
what type of fuse to use.

Caution: To conform with the EMC directive
(2004/108/EC), do not detach the plug from
the power cord.

Notice

C€

This product complies with the radio
interference requirements of the European
Community.

C€ 0560 (1) R&TTE Directive 1999I5/EC

BG vV [RO vV [BE V/IT /LI V]IS V/ISE /
bk VIES V/|cz /INL /[AT V[V /IsK /
FR VUK V[FI V/IPT VoY /mT /IpL /]
HU v NO vV |GR V[sI V[EE vV

T /W V]IE VIcH V[DE V

The device can be operated in the EU without
restrictions indoor, but cannot be operated
outdoors in France in the whole of the band
until further notice

This product complies with the requirement of
the 1999/5/EC directive.

Modifications

Modifications not authorized by the
manufacturer may void user's authority to
operate this product.

&b

Your product is designed and manufactured
with high quality materials and components,
which can be recycled and reused.

)i

When this crossed-out wheeled bin symbol is
attached to a product it means that the product
is covered by the European Directive 2002/96/
EC.

Please inform yourself about the local separate
collection system for electrical and electronic
products.

Please act according to your local rules and

do not dispose of your old products with your
normal household waste. Correct disposal of
your old product helps to prevent potential
negative consequences for the environment and
human health.

)54

Your product contains batteries covered by the
European Directive 2006/66/EC, which cannot
be disposed with normal household waste.
Please inform yourself about the local rules

on separate collection of batteries because
correct disposal helps to prevent negative
consequences for the environmental and
human heatth.



Information about the use of batteries:

“ Caution

* Risk of leakage: Only use the specified type of batteries.
Do not mix new and used batteries. Do not mix
different brands of batteries. Observe correct polarity.
Remove batteries from products that are not in use for
a longer period of time. Store batteries in a dry place.

* Risk of injury: Wear gloves when handling leaking
batteries. Keep batteries out of reach of children and
pets.

* Risk of explosion: Do not short circuit batteries. Do
not expose batteries to excessive heat. Do not throw
batteries into the fire. Do not damage or disassemble
batteries. Do not recharge non-rechargeable batteries.

Always bring your product to a professional to
remove the built-in battery.

Environmental information

All unnecessary packaging has been omitted.
We have tried to make the packaging easy to
separate into three materials: cardboard (box),
polystyrene foam (buffer) and polyethylene
(bags, protective foam sheet.)

Your system consists of materials which can
be recycled and reused if disassembled by

a specialized company. Please observe the
local regulations regarding the disposal of
packaging materials, exhausted batteries and old
equipment.

-
Made for

\ BiPod [JiPhone []iPad
[al

AirPlay

“Made for iPod,”*'Made for iPhone,” and “Made
for iPad” mean that an electronic accessory
has been designed to connect specifically to
iPod, iPhone, or iPad, respectively, and has

been certified by the developer to meet
Apple performance standards. Apple is not
responsible for the operation of this device

or its compliance with safety and regulatory
standards. Please note that the use of this
accessory with iPod, iPhone, or iPad may affect
wireless performance.

AirPlay, iPod, and iPhone are trademarks of
Apple Inc, registered in the U.S. and other
countries. iPad is a trademark of Apple Inc.

Class Il equipment symbol:

CLASS I apparatus with double insulation, and
no protective earth provided.

* The type plate is located on the bottom of the
apparatus.




2 Your
Entertainment
System

Congratulations on your purchase, and
welcome to Philips! To fully benefit from the
support that Philips offers, register your product
at www.philips.com/welcome.

If you contact Philips, you will be asked for the
model and serial number of this apparatus.The
model number and serial number are on the
bottom of the apparatus. Write the numbers
here:

Model No.

Serial No.

Introduction

Apple AirPlay technology enables you to play
your iTunes music library, hosted on a Mac, PC,
iPhone, iPod touch, or iPad on any AirPlay-
enabled device (for example, your DS3880W)
connected to the Wi-Fi network.
With an AirPlay-enabled device (for example,
your DS3880W), you can:
e stream audio from your iTunes music
library to any room in your house
*  choose which AirPlay-enabled devices
you want to play music on (if you
have more than one such devices in
your house)
e stream audio to multiple AirPlay-
enabled devices at the same time
(from the iTunes music library on your
PC/Mac only)

5

¢ Please visit www.philips.com/welcome for information
about more Philips AirPlay-enabled devices.
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With DS3880W, you can also:

»  charge your iPod/iPhone/iPad through
the USB socket with an Apple USB
cable (not supplied).

e play your iTunes music library on your
iPod/iPhone/iPad through the USB
socket directly while charging.

*  play music from other audio devices
through the MP3-LINK socket.

What’s in the box

Check and identify the contents of your
package:
+  DS3880W main unit (with a built-in
Wi-Fi module)
* 1 xAC power adapter
*  1xMP3link cable
¢ Charging stand

What else you need

To stream audio wirelessly by AirPlay, you need:
*  AWIi-Fi certified router
* A host for your iTunes music library,
for example, an iPod touch/iPhone/
iPad installed with iOS 4.2.3 (or later)
or a Wi-Fi enabled PC/Mac installed
with iTunes 10 (or later)
Your DS3880W should be connected to the
same local network as your iTunes host device
through the Wi-Fi router.



List of compatible iTunes host devices
for AirPlay

In terms of AirPlay, DS3880WV is compatible

with:

*  aWi-Fi enabled PC/Mac installed with
iTunes 10 (or later); and

*  the following iPod/iPhone/iPad models
installed with iOS 4.3 (or later):

e iPad?2

* iPad

*  iPhone 4

e iPhone 3GS

*  iPod touch (2nd, 3rd, and 4th
generation)
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Overview of the main unit

® ©

@ Power indicator

@ o

e Turn DS3880W on/off.

ORal

e Start or pause play.

@) +-
e Adjust volume.
*  (Press and hold both buttons) reset

DS3880WV.

@ Stand

(6) USB ==
e Connect an iPod/iPhone/iPad through
an Apple USB cable (not supplied).
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(Z) WI-FI SETUP button/indicator
*  Connect the unit to a Wi-Fi network.
*  Show the Wi-Fi connection status of
the unit.

MP3-LINK

»  Connect an external audio player
through the supplied MP3 link cable.

(® DCIN

*  Connect the power adaptor.



Get started to use AirPlay

To get started with AirPlay, you need to:

1 Upgrade your iPod touch/iPhone/iPad to
pg Y
the latest iOS version (I0S 4.2.3 or later).
e Orinstall the latest version of iTunes

(iTunes 10 or later) on your PC/Mac.

2 Connect power to DS3880W, then turn it
on (see ‘Prepare’ on page 36).

3 Connect DS3880W to your existing home
Wi-Fi network.

4 Make sure that your iPod touch/iPhone/
iPad or PC/Mac are also connected to the
same Wi-Fi network.
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3 Prepare

Always follow the instructions in this chapter in
sequence.

Connect power

n Caution

* Risk of product damage! Make sure that the power
supply voltage matches the voltage printed on the
bottom of the unit.

* Risk of electric shock! When you unplug the AC
adaptor, always pull the plug from the socket. Never
pull the cord.

* Before you connect the AC adaptor, make sure that you
have completed all the other connections.

DS3880WV is designed with a built-in battery
that allows you to enjoy music on the go.
Before use, make sure to fully charge the built-in
battery.

1 Dock the DS3880W main unit on the
charging stand.
2 Connect the AC power cord to
*  the DCIN socket on the back of the
charging stand.
*  the wall power socket.

36

* After AC power connection, if the built-in battery is full,

the power indicator on the front of the unit stays blue;
if the built-in battery is not full, the power indicator
flashes blue; if the battery is flat, the power indicator
turns red.

Turn DS3880WV on

Press O on the top to turn the unit on.

Wait for successful boot-up of the unit.
> The boot-up takes about 35 seconds.

> During boot-up, the Wi-Fi SETUP
indicator on the back of the unit blinks
green quickly.

> After boot-up, if no Wi-Fi connection
has been set up for DS3880WV, the
Wi-Fi SETUP indicator starts to blink
green slowly.

To turn the unit off, press O again.




4

Connect to
your home Wi-
Fi network for

AirPlay

To connect DS3880WV to your existing home
Wi-Fi network, you need to apply your home
Wi-Fi setting to DS3880WV.

You can do this in two ways (depending on
which type of Wi-Fi router you use):

Automatically - if your Wi-Fi router is
WPS (Wi-Fi Protected Setup)-enabled
and supports PBC (Push Button
Connection) (see ‘Scenario 1: Connect
to a WPS router on page 37)
Manually - if your Wi-Fi router does
not support WPS (see ‘Scenario 2:
Connect to a non-WPS router' on
page 38)

Once connected successfully,
DS3880W will remember your
home Wi-Fi settings. Then you can
enjoy AirPlay whenever DS3880WV is
powered on and connected to your
home Wi-Fi network automatically.
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Before connection of DS3880VV to
you home Wi-Fi network, check the
points below.

1 Make sure that your Wi-Fi router is
Y
powered on and working properly.

2 Make sure that DS3880W has been
powered on and booted up successfully
(see Turn DS3880W on' on page 36).

3 Identify the type of your Wi-Fi router (see
the user manual of your Wi-Fi router for
details).

Scenario 1: Connect to a
WPS router

* Before you press any button on DS3880WV, make sure
that DS3880W has been booted up successfully (see
Turn DS3880W on’ on page 36).

1 Press the WPS button on your home Wi-Fi
router.

2 Shortly after step 1, press Wi-Fi SETUP on
the back of DS3880WV.
> The Wi-Fi SETUP indicator blinks red,
yellow and green alternately.



5 Within 2 minutes, the WI-FI SETUP
indicator stops blinking and stays green,
and the unit beeps.

L DS3880W is connected to your home
Wi-Fi network successfully.

* For some Wi-Fi routers, you may need to hold the

WPS button for Wi-Fi connection or enable the WPS
PBC function from the router configuration pages. See
the user manuals of the specific routers for details.

If the Wi-Fi SETUP indicator on DS3880W blinks
yellow, it means that the Wi-Fi connection has failed.
Please wait for 2 minutes and try again. If the problem
remains, try to set up the Wi-Fi connection manually
(see ‘Scenario 2: Connect to a non-WPS router' on
page 38).

If the Wi-Fi connection fails again, press and hold both
the + and - buttons on the top of DS3880W to reset
it,and then try again.
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Scenario 2: Connect to a
non-WPS router

Note

* You can also follow the procedures below to connect
DS3880W to a WPS router manually.

To connect DS3880WV to a Wi-Fi router
manually, you need access to DS3880W's
built-in configuration web page for change of
its internal Wi-Fi settings. To do so, you need a
Wi-Fi enabled device with an Internet browser
for temporary Wi-Fi connection to DS3880WV.
The Wi-Fi enabled device can be an iPod touch/
iPhone/iPad or a Wi-Fi enabled PC/Mac.

Follow the sequence below for connection of
DS3880W to a non-WPS Wi-Fi router.

1 Collect settings of your home Wi-Fi router
and write down on paper for use during
DS3880W Wi-Fi setup (see ‘Collect
settings of your home Wi-Fi router’ on
page 39).

2 Switch DS3880W to Assisted Wi-Fi Setup
mode (see ‘Switch DS3880VV to Assisted
Wi-Fi Setup mode’ on page 39).
> A new Wi-Fi network created by

DS3880VV will appear, with the
network name (SSID) of Philips Fidelio
AirPlay.

3 Connect your Wi-Fi enabled device to the
created new Wi-Fi network temporarily (see
‘Connect your Wi-Fi enabled device to the
newly created Wi-Fi network’ on page 40).

4 Open the built-in web page of DS3880W
with the Internet Browser of your Wi-Fi
enabled device (see ‘Open the built-in web
page of DS3880W' on page 41).




Change the internal Wi-Fi settings of Switch DS3880WV to Assisted Wi-Fi

DS3880WV based on the settings you Setup mode

wrote on paper at step 1 (see ‘Change the

internal Wi-Fi settings of DS3880W’ on N

page 42). ote

Restore your\/\/i—Fi enabled device back * Before you press any button on DS3880W, make sure
- - . that DS3880W has been booted up successfully (see

to your existing home Wi-Fi settings (see Turn DS3880W on’ on page 36).

‘Restore your Wi-Fi enabled device back to
your existing home Wi-Fi setting’ on page 43).

Collect settings of your home Wi-Fi
router

Note
* Always consult the user manual of your home Wi-Fi
router for detailed instructions.

—_—

Connect your Wi-Fi enabled device to
your existing home Wi-Fi network.

Launch the Internet browser (for example, .
Apple Safari or Microsoft Internet | E
Explorer) on your Wi-Fi enabled device. N

WI-FI SETUP

=
3
@E
H

Open the configuration page of your

home Wi-Fi router.

Find the Wi-Fi settings tab and write down

the following information on paper:

@ Network name (SSID)

Wi-Fi security mode (usually WEP,
WPA or WPA?2 if enabled)

(©) Wi-Fi password (if Wi-Fi security is
enabled)

@ DHCP mode (enabled or disabled)

@ Static IP address settings (if DHCP
mode is disabled)

e Press and hold Wi-Fi SETUP on the back
of DS3880WV for more than 5 seconds.
5 The Wi-Fi SETUP indicator blinks
green and yellow alternately.

> A new Wi-Fi network created by
DS3880W will appear, with the
network name (SSID) of Philips Fidelio
AirPlay.

> |t may take up to 45 seconds for
successful creation of this new Wi-Fi
network.
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E Note 2 Select Philips Fidelio AirPlay from the list
of available networks.

* After you finish manual Wi-Fi setup for DS3880WV,
the new Wi-Fi network created by DS3880W will
disappear.

* If you fail to enter Assisted Wi-Fi Setup mode, power
off DS3880W and power on it, then try again after
successful boot-up.

* Make sure that there are no other Philips AirPlay-
enabled devices in Assisted Wi-Fi Setup mode at the
same time. Multiple Wi-Fi networks created this way

may interfere with each other.

Connect your Wi-Fi enabled device to
the newly created Wi-Fi network

The new Wi-Fi network created by DS3880W
only allows access of one Wi-Fi enabled device.
To avoid interference from any other Wi-Fi
devices, you are recommended to temporarily
disable the Wi-Fi function on your other Wi-Fi
devices.

Option 1: Use your iPod touch/iPhone/iPad

1 Select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.

3 Wait until successful Wi-Fi connection on
your iPod touch/iPhone/iPad.
= is displayed at the upper left corner
of your iPod touch/iPhone/iPad.

Tip

* If Philips Fidelio AirPlay is not in the list, try to scan the

@ Notifications ff » available Wi-Fi networks again.

Carrier >
Use your Wi-Fi enabled PC/Mac

Sounds > Note

Brightness > connect your PC/Mac to a Wi-Fi network.
¢ During Wi-Fi network connection, do not connect any
A network cable to your PC/Mac.

Wallpaper >

i—i * See the user manual of your PC/Mac for how to

1 Open the Wi-Fi setup tool or control
|@| General > panel on your PC/Mac.
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2 Scan the available Wi-Fi networks.

¥ Wireless Notwark Connoctlon fx
Hebwork Tasls Choose a wireless network

=== o =

o Sat up b wareleds natvork
fex i e or srnal cffcn

‘Searching for wireless networks i range...

3 Select Philips Fidelio AirPlay from the list
of available networks.

i Wireless Natwork Conrection X

Metwork Tasks Choose a wireless network
L Flomain: - o _
24 0t o weless rterc (1gy) - Connected T
For a home o smal cffice ‘i’ il
mmmm
(:TJ
mmmmm will

(‘TJ b s e n} St

mmm Ptork (WFAL) ill]]
(‘??) .

4 Wait until successful Wi-Fi connection on
your PC/Mac.

Wiralass Mo

wligs. Fadelbns APy

alated Tasks

L) Leaen st wriess
netisarirg

agmnt |
G Change advanced i Senurty-anabled wrsdess netmork all
i Setumibyrsabled wecles Fuknaceh Iﬂ
({iﬂl
¥ Sequrity-enabled wreless retwork. |Il]
gy == =
(e ]

M

Tip

* |f Philips Fidelio AirPlay is not in the list, try to scan the
available Wi-Fi networks again.

Open the built-in web page of
DS3880W

1 Launch Apple Safari browser or any other
Internet browser on your Wi-Fi enabled
device.

2 Type in 192.168.1.1 at the browser
address bar and confirm.
& The DS3880WV configuration web
page is displayed.

page. Follow the

ss speaker to your

device name change
Philips Fidelio device name: Philes_Fidsio 23985 A

Apply

Please select your wireless network and enter
your network password if applicable. For
advanced network setup, please click
Advanced; Click Apply to connect your wireless
speaker to your network.

Please select your Wi-Fi network: Select Oplicn [

If you use Safari on your Wi-Fi enabled PC/
Mac, you can also select ‘Philips_Fidelio XXX’
from the Bonjour pull-down list to enter the
DS3880WV configuration web page directly.



1 Click #% > Preferences.
% The Bookmarks menu is displayed.

DR e by R W HE
1t Bt s s i
PR o e MD o me) C o o

Fhilips Fidelio

eoscran| S Rt
Customize Toolbar...
[—— Pt Fid Men Ear
Pnugs Fe Hide Bookmarks Bar Ctrhshift+E8
Hide Tab Bar CeShift+T
Hide Status Bar ctrltf
History CtrlH
Downloads CtrlalL
Private Browsing
Reset Safari.
Block Pop-Up Windows — Chrl+ShiFt+K _=

[ E—
PESTr

Help F1
Rieport Bugs ko Apple

Safari Extensions Gallery
About Safar

2 Tick Include Bonjour for Bookmarks bar.

i [ Q=@ 8 B O

Generdl rarce |Bookmarks Mgl Secuky Extersions Advanced

[—— e
Bonhemarks sw: Irchachn bochmarks bar
[ trckuce Borgour
Colectionn: [ inehucks Borgos

3 Select 'Philips_Fidelio XXX' from the
Bonjour pull-down list shown at the
bookmarks bar.

L The DS3880W configuration web
page is displayed.

o somnest your i eless

Yahoo! — Go

Eonjour ¥ Apple ;;y‘.-mm..,
oo B St e

About Bonjour [ [E=5)

s
SCick Apalyio

sroper

== ()

[E—
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Change the internal Wi-Fi settings of
DS3880wW

On the DS3880WV configuration web page,
you can change the internal Wi-Fi settings of
DS3880WV for connection of DS3880W to
your existing home Wi-Fi network.

Note

* Make sure that the settings on the configuration web
page match your home Wi-Fi network settings that you
wrote on paper.

192.168.1.1 ¥

&

‘Welcome 1o Philips Fidelio setup page. Follow the
steps below o connect your wircless speaker to your
wireless network.

i Fideho

You can keep the default device name or
modify the device name by modifying the text
in the text bex. Click Agoly lo proceed with
device nama change.
Philips Fidelo device name: Phidos, Fusic 2108FA

Apiy.

Please salect your wiraless natwark and entar
your netwark password if applicable. For
advanced nebwork selup, please click
Advanced, Click Apply to connect your wireless
spaaker o your network.

Ploaso selact your Wi-Fi natwork:
e

*  Follow the on-screen instructions to
change and confirm the internal Wi-Fi
settings of DS3880WV.

L After a while, the indicator on the back

of DS3880W stops blinking and stays
green, and the unit beeps.

> DS3880W is connected to your
existing home Wi-Fi network
successfully.

|




* If the WI-FI SETUP indicator on DS3880WV does not
stay green steadily, it means that the Wi-Fi connection
has failed. Please power off both your Wi-Fi router
and DS3880W and then power on them again to see
whether DS3880W can be connected to your home
Wi-Fi network. If the problem remains, try the above
procedures again.

¢ After you finish the above changes or power-off and @

power-on of DS3880W, the new Wi-Fi network Notifications ft »

created by DS3880W will disappear.

Carrier >

Tip

¢ If you like, you can change the name of your DS3880W
in Advanced settings -> AirPlay Device Name on the

DS3880W configuration web page. This is helpful when W Brightness b3

Sounds >

you have multiple Philips AirPlay-enabled devices in
your house and you need to distinguish between them.

* If you want to enter the network name (SSID) manually
(for example, if you want to hide your SSID), go to
Advanced settings -> CONFIGURE MANUALLY on
the DS3880W configuration web page.

. Wallpaper >

|@| General >
Restore your Wi-Fi enabled device 2 Select your network name (SSID) from the
back to your existing home Wi-Fi list of available wireless networks.
setting S—
Note

* Make sure that the settings at steps 2 to 3 below match
your home Wi-Fi network settings you wrote on paper.

—_—

Select Settings -> Wi-Fi on your iPod

touch/iPhone/iPad.

*  Or open the list of available Wi-Fi
networks on your PC/Mac.

Other... >

Ask to Join Networks ! O ml! .

Known networks will be joined
automatically. If no known networks are

3 Enterthe network key if required.
Wait until successful Wi-Fi connection to
your home Wi-Fi network.

43



5 Play

Stream audio from your

iTunes music library to
DS3880W

=

* Make sure that your iTunes host device is connected
to the same Wi-Fi network as DS3880W.Your iTunes
device can be an iPod touch/iPhone/iPad installed with
iOS 4.3 (or later) or a Wi-Fi enabled PC/Mac installed
with iTunes 10 (or later).

Stream from your iPod touch/iPhone/
iPad

1 Launch the iPod application on your iPod
touch/iPhone/iPad.

2 Tap on the AirPlay icon.

Beethoven, compos

mphony Mo. 9 {Scherzo)

3 Select Philips_Fidelio XXXX (or user
customized name) from the AirPlay list.

& iPhone

&) Philips_Fidelio 21‘3
Cancel
4 Select a media file and start play.

> After a while, you will hear music from
DS3880WV.

van Beethoven, compos... =

Symphony No. 9 (Scherzo)

¢ I » &

=

* If you fail to hear music after successful setup, do one of
the following on your iPod touch/iPhone/iPad:

* (1) Disconnect and then re-connect to the same Wi-Fi
router again;

¢ (2) Close all applications running at the background;

* (3) Power off and then power on your iPod touch/
iPhone/iPad again.




Stream from your PC/Mac

1 Launch iTunes 10 (or a later version) on
your PC/Mac.

2 Clickthe AirPlay icon on the window.

=

lazxan

3 Select Philips_Fidelio_AirPlay XXXX (or
user customized name) from the AirPlay list.

w L My Computer

& Philips_F

Multiple Speakers..

LRI

4 Select a media file and start play.
> After a while, you will hear music from
DS3880W.

[
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* When you stream audio from your iTunes music library
on a PC/Mac, you can select more than one AirPlay-
enabled devices (if available) at step 3 to stream music
to all of them at the same time.

¢ If you are using an earlier version of iTunes, the AirPlay
icon may be € instead of [al.

Control play

You can select different play options from either
your iTunes host device or DS3880WV.

Note

* Make sure that you have successfully streamed audio
from your iTunes music library to DS3880W.

* o pause or resume play, press » 1.
e To adjust volume, press +/- repeatedly.

Tip

¢ If you are streaming music from a PC/Mac, to control
music play from DS3880W, remember to tick Allow
iTunes audio control from remote speakers in Edit ->
Preferences -> Devices on iTunes.

Use advanced sound settings

If your iTunes host device is an iPod touch/
iPhone/iPad:

For advanced sound settings and additional
features, you can use your iPod touch/iPhone/
iPad to download the Philips Fidelio application
from Apple App Store. It is a free application
from Philips.

If your iTunes host device is a Wi-Fi enabled
PC/Mac:



For advanced sound settings, you can use the
equalizer available on iTunes directly (View ->
Show Equalizer).

3 R

* See the iTunes help documentation for more details.

Play/charge your iPod/iPhone/
iPad through USB socket

Note

* The USB socket is only compatible with iPod/iPhone/
iPad.

* To avoid possible damage to DS3880WV, never try to
connect devices other than iPod/iPhone/iPad to the
USB socket on DS3880WV.

You can play or charge your iPod/iPhone/iPad
through the USB socket with an Apple USB
cable (not supplied).

If you have stopped audio streaming by AirPlay,
after successful USB connection, the unit
switches to the USB source automatically.
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*  Connect an Apple USB cable (not

supplied) to:

*  the USB <% socket on the back of
DS3880W.

*  the dock connector on your iPod/
iPhone/iPad.

3~

¢ With the built-in battery of DS3880W, you can play
your iPod/iPhone/iPad on the go.

* The built-in battery does not support charge of your
iPod/iPhone/iPad.

Comepatible iPod/iPhone/iPad

The USB socket supports play and charge of
the following iPod, iPhone, and iPad models.
* iPad?2

* iPad

* iPhone 4

*  iPhone 3GS
e  iPhone 3G

* iPhone

*  iPod classic

* iPod 5G

* iPod 4G

* iPod nano (2nd, 3rd, 4th, 5th, and 6th
generation)

* iPod touch (1st, 2nd, 3rd, and 4th
generation)

Play from an external device

You can also listen to an external audio player
through DS3880W.

If you have stopped both audio streaming by
AirPlay and direct music play through the USB
socket, DS3880WV switches to the MP3 link
source automatically.



Connect the supplied MP3 link cable to:

*  the MP3-LINK socket on the back of
DS3880WV.

* the headphone socket on an external
audio player.
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6 Update
firmware

To improve the performance of DS3880W,
Philips may offer you new firmware for upgrade
of your DS3880WV.

Please register your product at
www.philips.com/welcome for information
about the latest firmware.

Note

® You can only update the firmware from a PC/Mac.

Download the update file

@ i 2wl

i 1) | www.philips.com/support | l:_‘_ et l
| ‘
0 S%  United Kingdem / Englich B
Register your product / Login | XOXXX =
S G ]
- U

©| = XxXXXzp

=]

1 on your PC/Mac, go to
www.philips.com/support.

2 Enter the model number to find the latest
firmware upgrade file available.

3 Saethe upgrade file to your hard drive.

Update from the
configuration page

1\ Warning

* Always connect your DS3880W to AC power for
firmware upgrade. Never power off your DS3880W
during firmware upgrade.

Note

* To use an Internet browser other than Apple Safari
on your PC/Mac, remember to go to the Wi-Fi router
configuration page and write down the IP address of
your DS3880W. See the user manual of your Wi-Fi
router for how to find the IP addresses of devices
connected to the Wi-Fi router.

1 Power on DS3880W (see ‘Prepare’ on
page 36).
> |t takes about 35 seconds for the unit
to boot up. During boot-up, the WI-FI
SETUP indicator on the back of the
unit blinks green quickly.

> After boot-up, you can hear a beep
and the WI-FI SETUP indicator
turns to green steadily. DS3880W is
connected to the last configured Wi-Fi
network automatically.

2 Make sure that DS3880W and your PC/
Mac are connected to the same Wi-Fi
router.

3 Open Apple Safari on your PC/Mac, then
select 'Philips_Fidelio XXX’ from the
Bonjour pull-down list.

*  Or open any other Internet browser
on your PC/Mac, then type in the IP
address of DS3880WV (available on
the Wi-Fi router configuration page)
at the address bar.
> The DS3880VWV configuration

web page is displayed.



4

| Bomjour ¥ Apple  Yahoo!  Go
1 About Bonjour [ )

Philips_Fi

. a =N

Follow the on-screen instructions to
complete the firmware update.

=]

In case the firmware update fails, you can try the above
procedures again.

After successful firmware update, if there is any
problem with the Wi-Fi connection, press and hold
both the + and - buttons on DS3880W for more than
5 seconds at the same time to reset the device, and
then try to set up the Wi-Fi network for DS3880W
again.
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7 PI"OdLICt General information

information Fepoe Vo SO He
TAT2A
Output: 12V =
30A
Note Operation Power 3B5W
* Product information is subject to change without prior Consumption
notice. Power Consumptionin < 05W
Standby Mode
Dimensions
- Main Unit (LxW xH) 198 x100x 215 mm
Specifications Weight
- With Packing 1.95 kg
Amplifier - Main Unit 1.32 kg
Rated Output Power 4 X 4W RMS
Frequency Response 63 - 20 kHz
Signal to Noise Ratio > 75 dB

MP3 Link

650 mV RMS 20 kohm

Speakers

Speaker Impedance

8 ohm

Speaker Driver

40 mm full range

Sensitivity 78 dB/m/W
Wireless

Wireless 802.11b/g

standard

Wireless WEP (64 or 128 bit),

security WPA/WPA2 (8-63 characters)
Frequency 2412 - 2462 MHz (CH1-
range CH11) (for /79,137,155,197)

2412 - 2472 MHz (CH1-
CH13) (for /12, /10, /05)

PBC (one Yes
button push)
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8 Troubleshooting

I Warning

* Never remove the casing of this apparatus.

To keep the warranty valid, never try to repair
the system yourself.

If you encounter problems when using this
apparatus, check the following points before
requesting service. If the problem remains
unsolved, go to the Philips web site
(Www.philips.com/welcome).When you contact
Philips, ensure that the apparatus is nearby

and the model number and serial number are
available.

No power

*  Make sure that the AC power plug of the
device is connected properly.

*  Make sure that there is power at the AC
outlet.

*  Before you carry DS3880W for use on the
g0, make sure to fully charge the built-in
battery.

No sound

e Adjust the volume.

*  Check the Wi-Fi network connection. Set
up the network again if needed.

No response from the unit

e Press and hold both the + and - buttons
on DS3880W for more than 5 seconds
to reset the device. Then set up the Wi-Fi
network for DS3880WV again.

*  Disconnect and reconnect the AC power
plug, and then switch on the device again.

Wi-Fi network connection failed

*  Check if your Wi-Fi router is Wi-Fi
802.11b/g certified. This device is only
compatible with Wi-Fi 802.11b/g certified
routers.
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e If your Wi-Fi router is Wi-Fi 802.11n
certified, make sure to enable the
802.11b/g mode. DS3880W does not
support connection to routers with
802.11n only.

*  This device does not support the VWPS-
PIN method.

e If your Wi-Fi router supports WPS and
the WPS-PBC method but fails to connect
to DS3880WV, try the manual Wi-Fi setup
method (see ‘Scenario 2: Connect to a
non-WPS router' on page 38).

»  Enable SSID broadcast on the Wi-Fi router:

e Keep away from potential sources of
interference which may affect Wi-Fi signal,
such as microwave ovens.

e If you fail to use your PC for Wi-Fi network
setup, check whether your PC is using a
Wi-Fi network.You cannot use Ethernet
connection for AirPlay network setup.

e Make sure that the SSID name of your
home router consists of alphanumeric
characters, with no space or special
characters like %/#/* inserted.

*  If you choose to rename the AirPlay device
‘Philips_Fidelio XXXX' in the setting
menu, do not use special characters or
symbols.

e For some new types of Wi-Fi routers, a
network name (SSID) may be created
automatically when you use WPS for
connection. Always change the default
network name (SSID) to a simple one that
consists of alphanumerical characters, and
also change the Wi-Fi security mode to
secure your network.

Occasional breaking of AirPlay music

streaming

Do one or all of the following:

*  Move DS3880W closer to your Wi-Fi
router.

*  Remove any obstacles between DS3880W
and your Wi-Fi router.

e Avoid using Wi-Fi channel which is
overlapped by the nearby Wi-Fi network.



e Check if your network speed is fast enough
(in cases where multiple devices share the
same router; the AirPlay performance may
be affected). Turn off the other devices
connected to your home router.

*  Enable the Quality of Service (QoS)
option (if available on the Wi-Fi router).

e Turn off other Wi-Fi routers.

No AirPlay icon on my iTunes host device

e Make sure that DS3880W is already
connected to your home Wi-Fi network.

e Before you open iTunes, make sure that
you have enabled Bonjour service in
your PC.Take Windows XP for example:
to enable the service, you can click
Start->Control Panel, and double-click
Administrative Tools-> Services->Bonjour
Service, then click Start followed by OK
on the pop-up menu.

e If the problem remains, try to restart
DS3880WV.

AirPlay connection failed with Mac or PC

e Temporarily disable the firewall and
security software to see whether it blocks
the ports that AirPlay uses to stream
content. See the help documentation of
your firewall and security software on how
to unblock the ports used by AirPlay.

*  When you use iPod Touch/iPhone/iPad/
Mac/PC for AirPlay, if the music play breaks
or stops, try to restart your iPod Touch/
iPhone/iPad, iTunes or DS3880WV.

e Video streaming or FTP downloads may
overload your router and therefore may
cause interruptions during AirPlay music
play. Try to reduce the load of your router.
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